
Poster Printing Policies and Guidelines for AL
UMCES-AL provides a complimentary printing service for students, faculty, staff who need to

print a poster or other wide format print job for professional events, meetings, or other

activities. Following is a summary of the policies and procedures to request, create, and submit

large format print jobs for printing.

Please note that this is a free service and participants are expected to adhere to the policies as

outlined.  If you cannot meet the required deadlines or follow the procedures, you may be

charged for your print job ($8 per square foot) or you may have to find an outside printing

service for which you or your grant will have to pay.  Information about alternate online and

local services are provided later in this document.

How Do I Use This Service?

To submit a print request, please complete this form to add your job to our calendar. Ideally, you

should submit this form AS SOON AS you are notified that your poster has been accepted to the

meeting or as soon as you know that you will need to print a poster.  That allows staff to plan

accordingly and make arrangements for any planned absences.  Notice of at least one week is

required.

When Do I Need to Submit My File?

Allowing adequate time will help to ensure that we can print your poster successfully.

Therefore, if you have already completed the request form at least a week in advance and have

not heard otherwise, you will need to submit your poster to Katie Kline (kkline@umces.edu)

before noon on the last business day prior to departing for your conference via email.  For

example, if you are leaving on a Friday, your file must be submitted before noon on Thursday.

Be sure to plan ahead.  Printing is not available outside of normal business hours.  Business

hours are Monday through Friday between 8:00 am and 4:30 pm when the lab is open.  Use the

following table as a guide:

https://forms.gle/pW8TAECEcjLymoH6A
https://forms.gle/pW8TAECEcjLymoH6A


Conference/Meeting Departure Day File Submission Deadline

Sunday Before Noon of Previous Friday

Monday Before Noon of Previous Friday

Tuesday Before Noon on Monday

Wednesday Before Noon on Tuesday

Thursday Before Noon on Wednesday

Friday Before Noon on Thursday

Saturday Before Noon on Friday

Holiday Before Noon of Last Business Day Before
Holiday

Please note that prints can take anywhere from 30 minutes to several hours to complete

depending on file size and demand.  The print process includes set up, quality checks, buffering,

printing, drying, and trimming.  We can sometimes have four or more posters to print before

the larger, common meetings like ESA and AGU.  Furthermore, like any mechanical device, the

printer can sometimes break and require repair.  In these cases, someone will communicate

with you about the situation, but it’s always best to leave as much time as possible to account

for unforeseen circumstances.

How Long Does it Take to Prepare a Poster?

It is always best to allow for as much time as possible to complete your poster.  Experience

indicates that posters typically take much longer than you expect; sometimes twice or even

three times longer.  Unlike a talk, where you can tweak your slides almost up until the moment

that you present, the poster needs to be finalized before you leave for your meeting.  It is

recommended not to leave a poster until the last minute.

What Print Sizes Can AL Accommodate?

There are two widths of paper available at AL, which in the case of landscape orientation files is

the poster’s height:  36 inches and 42 inches.  We can accommodate a variety of widths

depending on the graphics program that you use to publish your poster.  The longest width

available in PowerPoint is 56 inches.  Therefore, the largest poster that you can create in



PowerPoint is 42 by 56 inches.  Other graphics programs, like InDesign and Illustrator, provide

more flexibility for the longer side allowing you to print a landscape orientation poster as wide

as 60” or 72” or more.  Common sizes include: 36x48”, 42x55”, 42x60”, and 42x72”.

Although sizes smaller than 42” or 36” on the shortest side can be used, they will require

trimming.  Your poster will look the best and require fewer post-printing modifications if you

choose one of the available paper widths for at least one of your poster dimensions, but be sure

to also consider the conference poster requirements.

How Large Should I Make My Poster?

The poster should conform to the size restrictions

imposed by the conference organizers while working

within AL’s options. Be sure to check with the organizers

about the size specifications. A landscape layout is more

popular and is usually easier to read.

The photograph to the right illustrates why portrait layout

is often bad for conference posters: a big chunk of the

poster “real estate” is below a viewer’s field of vision so

you viewers often need to stoop to see all of your content.

In What Format Should I Submit My
Poster File?

AL can print native files from PowerPoint, Adobe InDesign, Adobe Illustrator, and Adobe

Photoshop.  Alternatively, you may want to generate a PDF of your poster for submission,

though this is not required.  Generating the PDF ensures that no shifting of information, layout,

fonts or symbols will occur.  This shifting can sometimes occur when the native file is opened on

a different computer or operating system, though this seems to occur less often than it did 5 or

10 years ago.

To create a PDF from PowerPoint, which is the program with which this issue is most likely to

occur:

1. Select File > Export.

2. Click Create PDF/XPS Document, then click Create PDF/XPS. Note:  Do NOT choose the

“Create Adobe PDF” option.  This will create a low quality file that won’t print clearly.



3. In the Publish as PDF or XPS dialog box, choose a location to save the file and enter a

File name if you’d like to use a different name. Check to be sure that the file is

optimized for Standard and NOT Minimum size.

If you have any doubts about the size or quality of your file, create a PDF and confirm at 100%

magnification that colors, fonts, and images look perfect on your screen.  Another trick is to

upload the PDF to http://pdf-analyser.edpsciences.org/, which will give you a listing of the

resolutions of all images contained, plus will flag any fonts you’ve used but weren’t embedded

in the PDF. If you own Adobe Acrobat Pro, you can get the same information by running a

preflight diagnostic.

Alternative Printing Options

If for some reason, our printer is down, you’ve missed the deadline, or you need to make a last

minute reprint outside of normal business hours, you still do have some options, which are

summarized below.  Because things can change, it is recommended that you contact vendors as

soon as possible to ensure that they can still meet your requirements.

Lavale CVS Pharmacy
You can submit a file online with CVS and pick up the print job (usually within a few hours) from the CVS

Pharmacy in Lavale in sizes up to 24x36” for about $30. Visit the website to learn more.

UPS Store - Cumberland, MD

The UPS Store located at 725 Park St Cumberland, MD has the capability to print large format

posters of the 48”x36” size on glossy photo paper for about $75.  Their phone number is:

(301)724-4200. Additional information can be found on their website.

Staples - LaVale, MD

Staples located in LaVale, MD has the capability to print large format posters of the 48”x36” size

with same day pickup if the file is received by 2 pm and the poster picked up 30 minutes before

store closing.  Their price for a 48”x36” poster is about $100  Their phone number is: (301)

729-7840. Additional information is located on their website.

FedEx/Kinkos

There are no FedEx copy and print services available locally, but there are locations in

Hagerstown, MD, Greensburg, PA, Monroeville, PA, Winchester, VA, Frederick, MD, among

http://pdf-analyser.edpsciences.org/
https://graphicdesign.stackexchange.com/questions/5670/how-to-see-an-embedded-images-dpi-ppi-in-a-pdf-in-acrobat-pro
https://graphicdesign.stackexchange.com/questions/5670/how-to-see-an-embedded-images-dpi-ppi-in-a-pdf-in-acrobat-pro
https://www.cvs.com/photo/glossy-photo-posters-details#/bspview?ptype=posterprints&pcat=all_posters_63057_cvs_us&sku=CommerceProduct_47955&filters=skuList~CommerceProduct_47955&offset=0&view=BSP&defaultSkuSelection=true&bspOffset=0&isLoadMore=false
https://store5162.upsstoreprint.com/content/posters
https://www.staples.com/services/printing/same-day-services/posters/


others where one could coordinate a pick up of a printed poster for about $90 on their way to a

conference.  The largest size that they offer is 48”x36”. Learn more about Copy/Printing

Services at their website.

Online Services

If you’ve been the victim of unforeseen circumstances or just dropped the ball, it’s unlikely that

you could meet deadlines with an online printer and have the poster shipped to you in

Frostburg before you have to leave for your meeting.  Online Services could be an option,

though, if you arrange for shipment to your conference location/hotel. Here are a few sites that

offer online ordering for poster printing some of which offer same day shipping if you meet

their cutoff:

● https://www.makesigns.com/products/scientific-posters

● https://www.posterpresentations.com/price-guide.html

● https://phdposters.com/

● https://scientificposterprinting.com/

● https://www.postersession.com/

● https://www.posters4research.com/

● https://www.genigraphics.com/

● https://posterprintshop.com/

● https://www.creativemediaworks.com/Services/scientific-poster-printing/

● https://www.bestvaluecopy.com/site/posters-printing?gclid=EAIaIQobChMIrP3__OWh5

gIVla_ICh1eLwXdEAMYASAAEgJ9IvD_BwE#.XeqxW-hKiUk

● https://www.uprinting.com/large-format-posters-printing.html

General Poster Guidelines and Tips

UMCES Branding Guidelines

● When inserting logos into a poster with a solid but colored background, use a

transparent PNG format whenever possible to avoid appearances like this:

https://www.fedex.com/en-us/printing/posters/prints.html#details
https://www.fedex.com/en-us/printing/posters/prints.html#details
https://www.makesigns.com/products/scientific-posters
https://www.posterpresentations.com/price-guide.html
https://phdposters.com/
https://scientificposterprinting.com/
https://www.postersession.com/
https://www.posters4research.com/
https://www.genigraphics.com/
https://posterprintshop.com/?keyword=poster%20printing&gclid=EAIaIQobChMI8LnSv-Ch5gIVEsDICh0uIgdhEAAYBCAAEgLNzfD_BwE
https://www.creativemediaworks.com/Services/scientific-poster-printing/
https://www.bestvaluecopy.com/site/posters-printing?gclid=EAIaIQobChMIrP3__OWh5gIVla_ICh1eLwXdEAMYASAAEgJ9IvD_BwE#.XeqxW-hKiUk
https://www.bestvaluecopy.com/site/posters-printing?gclid=EAIaIQobChMIrP3__OWh5gIVla_ICh1eLwXdEAMYASAAEgJ9IvD_BwE#.XeqxW-hKiUk
https://www.uprinting.com/large-format-posters-printing.html?iv=__iv_p_1_a_7994034905_g_84052786042_c_222700925882_k_%2Bposter%20%2Bprinting_m_b_w_kwd-294845941326_n_g_d_c_v__l__t__r_1t2_x__y__f__o__z__i__j__s__e__h_9007951_ii__vi__&gclid=EAIaIQobChMIjZaypOah5gIVgYvICh2iigPsEAAYAiAAEgItDvD_BwE


● UMCES logo/branding guidelines can be found here:

https://www.umces.edu/sites/default/files/UMCES%20Logo%20Guidelines.pdf

● Always be sure to use the currently approved UMCES logo if you elect to include one on

your poster.  Files in both JPEG (white background) and PNG (transparent background)

formats can be downloaded here: https://www.umces.edu/logos-e-letterhead

Tips for Images and Graphics

● The resolution of each image inserted into your poster should be 150-300 dpi (or pixels

per inch) at the final printing size. Resolution below 150 dpi will result in a pixelated

image. Note that an image that looks good on the computer screen will not necessarily

print well.

● The following table can be used as a rough guide to assess the quality of your image or

graphics files:

Image Size Required Approximate File Size

4x6” 1.5MB

8x10” 5MB

8.5x11” 6MB

12x18” 14MB

24x36” 55MB

● Never copy and paste images, especially into PowerPoint.  Use Insert > Pictures

(PowerPoint) or File > Place (Adobe) to insert images and graphics.

● Using the SHIFT key when you resize graphics with your mouse will preserve the aspect

ratio

● Do not use WordArt in your poster. It is not of adequate quality to look sharp when

printed large.

● Provide the source of any image that is not yours. And only use images that are in the

public domain. When in doubt, ask the author/photographer/illustrator for permission.

● Keep graphs simple

○ Avoid “chart junk”: 3-D, shadowing, multiple grid lines, labeling every tick mark,

etc

○ With multiple graphs, combine information (e.g. share axis labels, titles, legends)

https://www.umces.edu/sites/default/files/UMCES%20Logo%20Guidelines.pdf
https://www.umces.edu/logos-e-letterhead


Selecting Colors

● Use no more than three main colors in your poster, excluding black and white.  Too many

colors can be distracting.

● Choose background colors to maximize contrast between the text and the background.

● Try to coordinate the colors used in your figures with the colors used in your poster.

● Background images can be impactful but they can also be distracting to readers.  If you

use a background image, be sure that your text is legible and that you employ

solid-colored opaque or semi-transparent background text boxes to minimize

distractions.  Gradient backgrounds can also be distracting.

● Dark solid backgrounds can sometimes print with noticeable lines. Make sure that your

contrast between background and text is adequate.

● Avoid neon colors.  They are hard on the eyes and usually don’t print in the same hue as

they are seen on screen.

● White text on a dark background works better for screens/slides, but not for printed

materials like a poster.

Selecting Fonts

● Serif vs. sans-serif - The font you choose for telling your story is almost as important as

the story itself. Most fonts in books, journals, and newspapers are serif fonts (i.e., the

letters feature small lines at the ends of strokes), while most screen/online content uses

sans-serif fonts. Serif fonts can help guide the reader’s eye along lines of text, and

certainly have a use in poster design, but serifs can also clutter text. Generally, sans-serif

fonts are best in graphic design, and widely available examples such as Arial, Calibri,

Helvetica, Verdana, and Tahoma can dramatically enhance the legibility of a poster over,

say, Times New Roman or Garamond.

● Select font colors to maximize contrast.

● Be consistent with your fonts.  Never use more than two different fonts in your poster.  It

is recommended to use a sans-serif font (e.g., Helvetica) for the title and headings and a



serif font (e.g., Palatino) for body text. Serif-style fonts are much easier to read at

smaller font sizes.

● Choose a font size and style that can be easily read from several feet away.

Recommended size ranges for fonts:

○ Title: 45 – 120 pt font, depending on title length. It’s OK to write titles in Bold

○ Headings, Authors/Institution: 30 – 60 pt font, depending on space

○ Body text: 18 – 30 pt font

● To emphasize a point, use bold or italics rather than underlining.

● All fonts that come with your operating system will embed in your poster file.  However,

if you are using a special font that you downloaded from the internet, you need to

ensure that it will embed in your file.  If you are not sure if your font has embedded,

open the file on a computer that does not have the special font installed.  If the image

viewer has replaced the font with something else, it means the special font was not

embedded in your file and your printed poster will not look the same.

● Let text wrap in the text box.  If you use hard returns and need to resize your text box

later, you will have to fix the returns.

● Preview your poster at 100% to make sure that your text boxes and images don’t overlap

(which can cause printing problems).

What If I Need to Resize My Poster?

Keep in mind that it’s usually impossible to make your poster significantly larger in size and still

look professional unless you are working with a vector-based program, like Illustrator or

InDesign.  It is best to plan ahead and start with the correct size before you start inserting

figures and images to your poster.  If you try to upscale them, they will appear pixelated and

grainy and you may have to recreate your poster from scratch at the larger dimensions.

Will the Poster Fill the Entire Page?

Print shops refer to an image filling the entire page/print surface as full page bleed.  That service

is not available at AL.  Your poster will have a thin white margin on all four sides, which we try to



minimize as much as possible.  You may elect to trim those white edges from the poster yourself

if you choose.

Designing for Deuteranopes

People tend to use red, green, and blue on white backgrounds, because those are simple colors

that are dark enough to stand out. But that can be a problem for deuteranopes.

Deuteranopia is one form of colour blindness. About 7-8% of men are color blind in one way or

another, with red-green color blindness of some form being the most common. Thus, chances

are that at a reasonably sized conference, someone walking past your poster could have issues

distinguishing colors that most of us take for granted.  In general, avoid using red and green

together, and opt to use symbols and line patterns (e.g., dashed vs. solid, open vs. solid) instead

of colors to distinguish between graph elements.  You can also run your images or graphs

through a color checker before inserting them into your poster.  Adobe Photoshop has a

color-blind simulator and there are some online applications, like:

https://www.color-blindness.com/coblis-color-blindness-simulator/.

General Guidelines

● Arrange your material in a logical progression and use columns or some other design

scheme to help create this progression.

● The number one mistake is to make a poster too wordy. Aim for 1000 words or less. That

might mean 700 words in paragraph form (body text), plus 300 words in the legends of

all your figures and tables.

● Don’t try to cram too much onto your poster, sacrificing legibility and visual flow.  Give

your content “breathing room”.  A cramped poster is hard to read, and the brain simply

cannot effectively process the information provided, regardless of how amazing it is.

● Size your poster file correctly BEFORE you start adding any content.

● Whenever possible, use lists of sentences, or bullet points, rather than large blocks of

text.

● Make sure that details on graphs and photographs can be comfortably viewed from 6

feet away. A common mistake is to assume that axes labels, figure legends, and numbers

on axes are somehow exempt from font-size guidelines. The truth is that the majority of

viewers want to read only your figures.

● If you have trouble understanding the difference between “effect” and “affect,” it’s

probably best to avoid using those words.

● Try not to clutter the top of your poster with logos. If you are required by your mentor or

collaborators to include logos on your poster, put them on the bottom of the poster and

https://www.color-blindness.com/coblis-color-blindness-simulator/


make them small. Here is an example image of a poster with logos at the top if you’d like

see why it’s a graphical fail.

● Fresh eyes are helpful.  Save time and costs for re-prints by allowing sufficient time for

review by peers, your advisor, or your co-author(s).  Take advantage of the large

monitors in the Administrative Conference Room or the Library to view your poster close

to its printed size.

PowerPoint Templates

There are a number of sources for templates that can save you a significant amount of

preparation time that have been constructed with appropriate font sizes and harmonious color

schemes:

● https://www.makesigns.com/SciPosters_Templates.aspx

● PowerPoint Poster Templates

● https://phdposters.com/templates

● https://postersmith.com/poster

● https://www.genigraphics.com/templates

Poster Repositories for Inspiration
● https://www.eposters.net/posters/

● https://f1000research.com/browse/posters?&selectedDomain=posters

Helpful Links
● https://libguides.usc.edu/healthsciences/posters

● https://projects.ncsu.edu/project/posters/index.html

● https://www.kmeverson.org/academic-poster-design.html

● https://ugs.utexas.edu/our/poster

● https://betterposters.blogspot.com/2011/04/using-grids-in-powerpoint.html

● https://blogs.nicholas.duke.edu/fuelforthought/how-to-print-your-conference-poster/

● https://www.mc.vanderbilt.edu/documents/evidencebasedpractice/files/Step%20by%20Step-Po

ster%20making%20tips.pdf

https://colinpurrington.com/wp-content/uploads/2011/09/logos-poster-top-purrington.jpg
https://colinpurrington.com/wp-content/uploads/2011/09/logos-poster-top-purrington.jpg
https://www.makesigns.com/SciPosters_Templates.aspx
https://drive.google.com/drive/folders/1l2wlDcNNV183HuX1G9I_wydTxP6XAKIl?usp=sharing
https://phdposters.com/templates
https://postersmith.com/poster
https://www.genigraphics.com/templates
https://www.eposters.net/posters/
https://f1000research.com/browse/posters?&selectedDomain=posters
https://libguides.usc.edu/healthsciences/posters
https://projects.ncsu.edu/project/posters/index.html
https://www.kmeverson.org/academic-poster-design.html
https://ugs.utexas.edu/our/poster
https://betterposters.blogspot.com/2011/04/using-grids-in-powerpoint.html
https://blogs.nicholas.duke.edu/fuelforthought/how-to-print-your-conference-poster/
https://www.mc.vanderbilt.edu/documents/evidencebasedpractice/files/Step%20by%20Step-Poster%20making%20tips.pdf
https://www.mc.vanderbilt.edu/documents/evidencebasedpractice/files/Step%20by%20Step-Poster%20making%20tips.pdf

